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・ The information in this document is current as of 27.12.2004. The information is subject to change 
without notice. For actual design-in, refer to the latest publications of NEC Electronics data sheets or 
data books, etc., for the most up-to-date specifications of NEC Electronics products. Not all products 
and/or types are available in every country. Please check with an NEC sales representative for 
availability and additional information. 

 
・ No part of this document may be copied or reproduced in any form or by any means without prior 

written consent of NEC Electronics.  NEC Electronics assumes no responsibility for any errors that 
may appear in this document. 

 
・ NEC Electronics does not assume any liability for infringement of patents, copyrights or other 

intellectual property rights of third parties by or arising from the use of NEC Electronics products listed 
in this document or any other liability arising from the use of such NEC Electronics products.  No 
license, express, implied or otherwise, is granted under any patents, copyrights or other intellectual 
property rights of NEC Electronics or others. 

 
・ Descriptions of circuits, software and other related information in this document are provided for 

illustrative purposes in semiconductor product operation and application examples.  The incorporation 
of these circuits, software and information in the design of customer's equipment shall be done under 
the full responsibility of customer.  NEC Electronics no responsibility for any losses incurred by 
customers or third parties arising from the use of these circuits, software and information.  

 
・ While NEC Electronics endeavors to enhance the quality, reliability and safety of NEC Electronics 

products, customers agree and acknowledge that the possibility of defects thereof cannot be 
eliminated entirely.  To minimize risks of damage to property or injury (including death) to persons 
arising from defects in NEC Electronics products, customers must incorporate sufficient safety 
measures in their design, such as redundancy, fire-containment and anti-failure features. 

 
・ NEC Electronics products are classified into the following three quality grades: “Standard”, “Special” 

and “Specific”. 
 

The "Specific" quality grade applies only to NEC Electronics products developed based on a customer-
designated “quality assurance program” for a specific application.  The recommended applications of NEC 
Electronics product depend on its quality grade, as indicated below.  Customers must check the quality 
grade of each NEC Electronics product before using it in a particular application. 
 
"Standard": Computers, office equipment, communications equipment, test and measurement 
  equipment, audio and visual equipment, home electronic appliances, machine tools, 
  personal electronic equipment and industrial robots. 
 
"Special":  Transportation equipment (automobiles, trains, ships, etc.), traffic control systems, anti- 
   disaster systems, anti-crime systems, safety equipment and medical equipment (not 
   specifically designed for life support). 
 
"Specific":  Aircraft, aerospace equipment, submersible repeaters, nuclear reactor control systems,  
   life support systems and medical equipment for life support, etc. 
 
The quality grade of NEC Electronics products is “Standard” unless otherwise expressly specified in NEC 
Electronics data sheets or data books, etc. If customers wish to use NEC Electronics products in 
applications not intended by NEC Electronics, they must contact NEC Electronics sales representative in 
advance to determine NEC Electronics 's willingness to support a given application. 
 
Notes:  1." NEC Electronics" as used in this statement means NEC Electronics Corporation and also 
    includes its majority-owned subsidiaries. 

 2. " NEC Electronics products" means any product developed or manufactured by or for NEC 
  Electronics (as defined above). 
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Low Pin Count - Do it! complies with the EMC protection requirements 
 
 
 
 

WARNING 
 
This is a ‘Class A’ ( EN 55022 : 1998) equipment. This equipment can cause radio 
frequency noise when used in the residential area. In such cases, the user/operator of 
the equipment may be required to take appropriate countermeasures under his 
responsibility. 

EEDT-ST-001-11 
 
 
 
 
 

CAUTION 
 

This equipment should be handled like a CMOS semiconductor device. The user must 
take all precautions to avoid build-up of static electricity while working with this 
equipment. All test and measurement tool including the workbench must be grounded. 
The user/operator must be grounded using the wrist strap. The connectors and/or 
device pins should not be touched with bare hands. 

EEDT-ST-004-10 
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1. Introduction 
Low Pin Count – Do it! is a demonstration kit for the NEC’s 78K0S Low Pin Count microcontrollers. 
It supports onboard FLASH programming and real time execution of application programs up to 4 kBytes 
based on the 78K0S/KA1+ Low Pin Count microcontroller. The board is prepared to be connected to user 
hardware parts such as digital I/O or analogue signals. 

1.1 Main features of Low Pin Count – Do it! 

• Easy to use device demonstration capabilities 
Low Pin Count - Do it! contains elements to easily demonstrate simple I/O-functions, i.e. push 
buttons, LED output, AD reference voltage, I/O lines, UART interface. 

 
• Power supply via USB interface 

Low Pin Count - Do it! is powered via USB interface, no separate power supply is needed. 
 

• PG-LPC, FLASH programming software 
A windows based FLASH programming software allows to select and download application programs 
to Low Pin Count - Do it! board for evaluation purposes. 

 
• Analogue to digital signal conversion is supported 
 
• Various input / output signals available, such as 
 

° All I/O ports prepared to be connected to user hardware 
° Timer input / output signals 
° UART interface, via USB UART chip FT232 
° 4 analogue input lines 
° 4 I/O ports connected to LED’s 
° 1 push button prepared for external interrupt generation 
 

• The IAR Embedded Workbench for 78K0/78K0S and the IAR C-SPY simulator are included. These 
packages are restricted in such that maximum program code size is limited to 4 kByte of program 
code. 
 

• Full documentation is included for the NEC 78K0S/KA1+ microcontroller, IAR Systems Embedded 
Workbench, IAR Systems C-SPY simulator and PG-LPC FLASH programming software. 

 
 
 
 

Low Pin Count - Do it! is not intended for code development. NEC does not allow and does not 
support in any way any attempt to use Low Pin Count - Do it! in a commercial or technical 
product. 
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1.2 System requirements 

 
HOST PC A PC supporting Windows 98SE, Windows ME, Windows 2000 or 

Windows XP is required for the IAR Systems Embedded Workbench 
demo-version and the PG-LPC FLASH programming software. 
Pentium 166 MHz (at least), 64 MB of RAM, 256-color display (1024 * 
768), mouse, CD-ROM drive and 40 Mbytes of free hard disk space are 
required to install the tool packages. 
 
Above listed requirements are valid if the IAR Systems Embedded 
Workbench and the PG-LPC FLASH programming software shall be 
installed. 
 

Host interface USB interface that enables communication based on USB (Ver1.1 or 
later) 
 

1.3 Package contents 
Please verify that you have received all parts listed in the package contents list attached to the  
Low Pin Count - Do it! package. If any part is missing or seems to be damaged, please contact the 
dealer from whom you received your Low Pin Count - Do it!. 
 
Note: Updates to this User Manual, additional documentation and/or utilities for Low Pin Count - Do 

it!, if available,  may be downloaded from the NEC WEB page(s) at 
http://www.ee.nec.de/updates. 
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2. Low Pin Count - Do it! system configuration 
The Low Pin Count - Do it! system configuration is given in the diagram below: 
 

 
Figure 1: Low Pin Count - Do it! system configuration 

2.1 Low Pin Count - Do it! 
Low Pin Count - Do it! is a demonstration kit for the NEC 78K0S Low Pin Count devices. The 
µPD78F9222 microcontroller is a typical device from this family and it has been used to realise the 
Low Pin Count - Do it!. 
 
The Low Pin Count - Do it! board is connected to the host system via USB interface cable. The host 
system may be used for programming of µPD78F9222 FLASH memory and to allow execution of 
application programs on Low Pin Count - Do it! platform. 
 
Low Pin Count - Do it! runs the µPD78F9222 microcontroller at 8.00 MHz operating speed.  
 

2.2 Host computer 
The USB host interface enables communication to the Low Pin Count - Do it! board. The USB UART 
chip FT232 allows application software to access the USB device in the same way as it would access a 
standard RS232 interface. The FTDI's Virtual COM Port ( VCP ) driver appears to the windows system 
as an extra Com Port, in addition to any existing hardware Com Ports.  
 
For a detailed specification of the host interface please refer to the chapter “Connectors and Cables” of 
this document. 
 

2.3 Power supply via USB interface 
Low Pin Count - Do it! is powered by USB interface, no separate power supply is needed. The USB 
interface provides the Low Pin Count - Do it! board with 5V supply voltage. 
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3. Low Pin Count - Do it! board components 
The Low Pin Count - Do it! board is equipped with push buttons, LED’s and with several connectors in 
order to be connected to host computers or connect any target hardware. Additionally the Low Pin Count 
- Do it! board provides a wire wrap field (2,54 mm grid) to integrate user application hardware. 
 

 
 

Figure 2: Low Pin Count - Do it! board connectors, switches and LED’s 

 
All of the Low Pin Count - Do it! µPD78F9222 on-chip resources are free for user application hardware 
and software. Please read the user’s manual of the 78K0S/KA1+ device carefully to get information 
about the electrical specification of the available I/O ports before you connect any external signal to the 
Low Pin Count - Do it! board! 
 
 

3.1 Configuration switch SW3 
The different operation modes of the Low Pin Count - Do it! board can be set by SW3 switches S1-S4.  
 

SW3 Factory settings Function 
S1 OFF Normal operation mode 
S2 OFF No UART 
S3 OFF CPU clock = 8 MHz 
S4 OFF No handshake for UART 

Table 1: Configuration switch SW3, factory settings 
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3.1.1 Operation mode selection SW3/S1 

SW3 switch S1 controls the operation mode of the Low Pin Count - Do it! board. Setting SW3/S1 to ON 
allows to reprogram the internal FLASH memory of the 78K0S/KA1+ device using the PG-LPC FLASH 
programming software. 
 
 

SW3, S1 Operation mode 
OFF (default) Normal operation mode 
ON FLASH memory programming mode 

Table 2: Operation mode selection SW3/S1 

 
Within normal operation mode the user program stored in the FLASH memory of 78K0S/KA1+ device is 
executed. 
 

3.1.2 UART selection SW3/S2 
SW3 switch S2 controls the serial communication of Low Pin Count - Do it! board. The UART6 signals 
RxD6 and TxD6 are connected to the FT232 interface lines when setting SW3/S2 to ON. 
 
 

SW3, S2 Operation mode 
OFF (default) RxD6 / TxD6 disconnected 
ON RxD6 / TxD6 connected to FT232 interface lines 

Table 3: UART selection SW3/S2 

 

3.1.3 Clock mode selection SW3/S3 

SW3 switch S3 controls the clock operation frequency of the Low Pin Count - Do it! board.  
 
 

SW3, S3 Operation mode 
OFF (default) Clock frequency = 8 MHz 
ON Clock frequency = 4 MHz 

Table 4: Clock mode selection SW3/S3 

 

3.1.4 UART mode selection SW3/S4 

SW3 switch S4 controls the UART communication mode of Low Pin Count - Do it! board. Setting 
SW3/S4 to ON enables UART communication with handshake. Within this mode the CPU pins P40 and 
P41 are connected to the FT232 interface lines and used as RTS and CTS control signals. 
 
 

SW3, S4 Operation mode 
OFF (default) UART communication without handshake 
ON UART communication with handshake 

(P40=RTS; P41=CTS) 

Table 5: UART mode selection, SW3/S4 
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3.2 User button SW1 

SW1 is a push button connecting VSS to external interrupt input INTP0 of the CPU. This is equal to port 
P30 of the 78K0S/KA1+ CPU. The port may be programmed to generate interrupt INTP0. The necessary 
initialisation for this purpose is described in the user’s manual of the 78K0S/KA1+device. Pressing this 
button will apply low signal level at port P30. 
 

3.3 Start button SW2 

SW2 is a reset button. It activates the power on reset. It is connected to the reset input of the CPU. 
Pressing this button will apply low signal level at the RESET pin. 
 

3.4 USB interface connector CN7 
CN7 connector allows connecting the PG-LPC FLASH programming software to the 
Low Pin Count - Do it! board in order to program application programs into the CPU internal flash. The 
board power supply of 5V is also provided by connector CN7. 
 
Additionally connector CN7 connects UART6 of the 78K0S/KA1+ device to the host system. 
 

3.5 Connector CN1 / Clock configuration 
Connector CN1 is used to define the operating clock of the Low Pin Count - Do it! board. Closing the 
connectors CN1/3-5 and CN1/4-6 (default setting) provides 8 MHz clock frequency to the 78K0S/KA1+ 
device. In this mode the clock frequency is supplied by the CPLD. 
 
Alternative an external crystal oscillator can be equipped to the Low Pin Count - Do it! board. To use this 
operation mode close connectors CN1/1-3 and CN1/2-4. 
 

CN1 Jumper setting  Mode 
1-2 
3-5 
4-6 

open     (default) 
closed  (default) 
closed  (default) 

Clock frequency = 8 MHz, supplied by CPLD 

1-3 
2-4 
5-6 

closed 
closed 
open 

Clock supply by external oscillator. By using this 
mode be sure to equip a crystal oscillator and 
corresponding capacitors to X1, C12 and C11. 

Table 6: Connector CN1, clock configuration 
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3.6 Connectors CN2 / CN12 / external peripheral configuration  

Connectors CN2 and CN12 allow connecting and disconnecting of the external board hardware to the 
78K0S/KA1+ device. 
 

CN2 Jumper setting Mode 
1-2 closed (default) RESET pin connected to CPLD 
3-4 closed (default) RESET pin connected to button SW2 
5-6 closed (default) INTP0 pin connected to button SW1 
7-8 closed (default) P40 connected to CPLD (RTS line of FT232) 
9-10 closed (default) P41 connected to CPLD (CTS line of FT232) 

Table 7: Connector CN2, external peripheral configuration 

 
CN12 Jumper setting Mode 
1-2 closed (default) Power supply, Vcc=5V connected to 

78K0S/KA1+ and external potentiometer R24 
3-4 closed (default) AVREF pin connected to Vcc  
5-6 closed (default) ANI0 pin connected to R24 potentiometer arm 
7-8 closed (default) P44/RxD6 connected to CPLD  

(RxD line of FT232) 
9-10 closed (default) P43/TxD6 connected to CPLD  

(TxD line of FT232) 

Table 8: Connector CN12, external peripheral configuration 

3.7 External Potentiometer R24 

A 10k potentiometer R24 is connected between Vcc and ground. Vcc is supplied to R24 by closing 
connector CN12/1-2. The potentiometer arm can be connected to the ANI0 analogue input of the 
78K0S/KA1+ device by closing connector CN12/5-6. 
 

3.8 AD converter reference voltage input 
The reference voltage of the potentiometer R24 can be supplied to the AVREF input by closing connector 
CN12/3-4. 
 

3.9 External LED’s D1–D4 
The LED’s D1-D4 are connected to the 78K0S/KA1+ device and are free for user application purposes. 
The LED’s are connected via a 4,7k Pull-up resistor to Vcc and therefore active low. 
 
 

Port LED 
P23 D1 
P130 D2 
P45 D3 
P123 D4 

Table 9: LED D1-D4 connection 

 
For disconnecting a LED from a port for alternative usage cut the connection (default) of the 
corresponding soldering bridge SB1-SB4. 



Low Pin Count – Do it!  

16 

 

3.10 External connectors CN3,CN4, CN5, and CN6 

 
CN3, CN4, CN5, and CN6 are connectors for external user hardware. All CPU signals are connected to 
CN3, with the exception of X1 and X2 signals. The Low Pin Count - Do it! board provides a wire wrap 
field - connectors CN4, CN5 and CN6 - allowing the integration of additional application hardware.  
 

Table 10: External connectors CN3, CN4, CN5 and CN6 

CN3  CN3   CN6  CN6   CN5  CN5   CN4  CN4  
39 VCC 40 AVREF  39 N.C. 40 N.C.  39 N.C. 40 N.C.  2 N.C. 1 GND 
37 VCC 38 P20  37 N.C. 38 N.C.  37 N.C. 38 N.C.  4 N.C. 3 GND 
35 VCC 36 P21  35 N.C. 36 N.C.  35 N.C. 36 N.C.  6 N.C. 5 GND 
33 VCC 34 P22  33 N.C. 34 N.C.  33 N.C. 34 N.C.  8 N.C. 7 GND 
31 VCC 32 P23  31 N.C. 32 N.C.  31 N.C. 32 N.C.  10 N.C. 9 GND 
29 VCC 30 P130  29 N.C. 30 N.C.  29 N.C. 30 N.C.  12 N.C. 11 GND 
27 VCC 28 P45  27 N.C. 28 N.C.  27 N.C. 28 N.C.  14 N.C. 13 GND 
25 VCC 26 P44  25 N.C. 26 N.C.  25 N.C. 26 N.C.  16 N.C. 15 GND 
23 VCC 24 P43  23 N.C. 24 N.C.  23 N.C. 24 N.C.  18 N.C. 17 GND 
21 VCC 22 P42  21 N.C. 22 N.C.  21 N.C. 22 N.C.  20 N.C. 19 GND 
19 VCC 20 P41  19 N.C. 20 N.C.  19 N.C. 20 N.C.  22 N.C. 21 GND 
17 VCC 18 P40  17 N.C. 18 N.C.  17 N.C. 18 N.C.  24 N.C. 23 GND 
15 VCC 16 P30  15 N.C. 16 N.C.  15 N.C. 16 N.C.  26 N.C. 25 GND 
13 VCC 14 P31  13 N.C. 14 N.C.  13 N.C. 14 N.C.  28 N.C. 27 GND 
11 VCC 12 RESET  11 N.C. 12 N.C.  11 N.C. 12 N.C.  30 N.C. 29 GND 
9 VCC 10 VDD  9 N.C. 10 N.C.  9 N.C. 10 N.C.  32 N.C. 31 GND 
7 VCC 8 P123  7 N.C. 8 N.C.  7 N.C. 8 N.C.  34 N.C. 33 GND 
5 VCC 6 N.C.  5 N.C. 6 N.C.  5 N.C. 6 N.C.  36 N.C. 35 GND 
3 VCC 4 N.C.  3 N.C. 4 N.C.  3 N.C. 4 N.C.  38 N.C. 37 GND 
1 VCC 2 VSS  1 N.C. 2 N.C.  1 N.C. 2 N.C.  40 N.C. 39 GND 

 
(N.C. = Not Connected) 
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4. 78K0S/KA1+ memory map 
 
The memory layout of the µPD78F9222 4 kByte FLASH ROM device is shown in the table below. 
 

0xFFFF   
 SFR Area  
 256 x 8 bits  
0xFF00  Free for application 
0xFEFF  software 
 Internal high speed RAM  
 256 x 8 bits  
0xFE00   
0xFDFF   
   
 Use prohibited  
   
0x1000   
0x0FFF   
 Flash memory Free for application  
 4096 x 8 bits software 

A
dd

re
ss

  a
re

a 

0x0000   

Table 11: 78K0S/KA1+ memory map 

 
The Low Pin Count - Do it! board does not reserve any resources of the 78K0S/KA1+ device, 
consequently all available memory of the device is free for application software. 
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5. Low Pin Count - Do it! installation and operation 

5.1 Getting started 
 
The windows based PG-LPC FLASH programming software allows to select and download application 
programs to Low Pin Count – Do it! board. As communication interface between PC host system and the 
Low Pin Count – Do it! board a USB interface line is needed. Before you can download and run a 
program, hardware and software must be installed properly. 
 

5.1.1 CD-ROM contents 

 
The CD-ROM shows following directory structure: 
 

 
CD-ROM ROOT 
 
- Acrobat Reader for 32Bit Windows OS 
 
- Documentation 
 
- IAR Embedded Workbench 78K0/78K0S 
 
- PG-LPC FLASH programming software, incl. USB 
  Drivers 
- Sample programs for Low Pin Count - Do it! 
 
 … AD converter demonstration 
 
 … Light Show 
 
 … Reaction time measurement 
 
 … Timer demonstration 
 
 … UART demonstration 
 
 
 
 

 

 

Table 12: Low Pin Count - Do it! CD-ROM directory structure  
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6. Hardware installation 
After unpacking Low Pin Count - Do it! connect the board to your host computer using the provided USB 
interface cable. When Low Pin Count - Do it! is connected, the USB driver needs to be installed on the host 
machine. Please refer to the following chapter “Software Installation”. 
 

7. Software installation 
The Low Pin Count - Do it! package comes with the several software demo packages: 
• IAR Systems Embedded Workbench for 78K0/78K0S, including C compiler, assembler, linker, librarian 

and IAR C-SPY simulator 
• PG-LPC FLASH programming GUI 
• Sample programs 
 
The IAR Systems Embedded Workbench and the PG-LPC FLASH programming GUI must be installed on 
your PC. For detailed installation hints, refer to the following chapters and to the corresponding 
documentation of the IAR Embedded Workbench. 
 
The sample programs can be downloaded to the Low Pin Count - Do it! board directly from the CDROM. 
Only if you intend to modify or debug (simulate) the sample programs it is necessary to copy the complete 
\SamplePrograms folder to your local hard disk. 
 
Remark:  Before modification or re-building of sample programs, do not forget to remove 

“Read-only” attribute of copied files. 
 
 

7.1 IAR Systems Embedded Workbench for 78K0/78K0S installation 
To install the IAR Systems Embedded Workbench for 78K0/K0S including C-SPY simulator, select the 
SETUP program in the directory \IAR Embedded Workbench 78K\ew78k\ of the CDROM. The setup 
dialogues will guide you through the installation process. 
 

7.2 PG-LPC FLASH programming GUI installation 
To install the PG-LPC FLASH programming GUI select the SETUP program in the directory \PG-LPC\ of 
the CDROM. The setup dialogues will guide you through the installation process. 
 

7.3 Sample program installation 

The sample programs do not require any installation for download to the Low Pin Count - Do it! board. If the 
sample programs shall be modified it is required to copy them into any directory of your local hard disk. A 
file copy using the Windows explorer is the recommended procedure.  
 
Remark:  Before modification or re-building of sample programs, do not forget to remove 

“Read-only” attribute of copied files. 
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7.4 Driver Installation 

When Low Pin Count - Do it! board is used, the driver needs to be installed on the host machine. After the 
PG-LPC FLASH programming software has been installed successfully a new folder “C:\Program 
Files\NECTools32\PG-LPC\DRIVERS” was generated, containing the necessary drivers. Install the driver 
according to the following procedure: 
 

Installation on Windows 98SE/Me .........  Page 20 
Installation on Windows 2000 ...............  Page 22 
Installation on Windows XP ...................  Page 28 

 

7.4.1 Installation on Windows 98SE/Me 
 

1. When the Low Pin Count - Do it! board is connected with the host machine, the board is 
recognized by Plug and Play, and the wizard for adding new hardware is started.  Click 
Next>. 

 

Figure 3: Add New Hardware Wizard (Windows 98SE ) 

 
 

 
2. The window below is displayed. So, check that "Search for a suitable driver ..." is selected, 

then click Next>. 

Figure 4: Search Method (Windows 98SE) 

 

Click. 

Check that "Search for a 
suitable driver ..." is selected. 

Click. 
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3. Check the "Specify a location" check box only and enter "C:\Program 

Files\NECTools32\PG-LPC\DRIVERS" in the address bar, then click Next>. 
 

Figure 5: Search Location Specification (Windows 98SE) 

 
 
 
 

 
Remark If the installation destination folder is changed at the time of PG-LPC software 

installation, enter "new-folder\PG-LPC\DRIVERS". 
 
 

4. The window below is displayed.  Click Next>. 
 

Figure 6: Checking Driver to Be Installed (Windows 98SE) 

 
 

<1> Check "Specify 
a location" only. 

<3>  Click. 

<2>  Enter "C:\Program Files\NECTools32\PG-LPC\DRIVERs". 

Click. 
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5. When the window below is displayed, the installation of the USB driver is completed.  Click 

Finish.  The installation of the USB Serial Port driver is then automatically performed. 
 

Figure 7: Installation Completion (Windows 98SE) 

 
 

 
 
 

7.4.2 Installation on Windows 2000 
 

1. When the Low Pin Count - Do it! board is connected with the host machine, the board is 
recognized by Plug and Play, and the wizard for finding new hardware is started.  Click 
Next>. 

 

Figure 8: Found New Hardware Wizard 1 (Windows 2000) 

 

Click. 

Click. 
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2. The window below is displayed.  So, check that "Search for a suitable driver ..." is selected, 

then click Next>. 
 

Figure 9: Search Method 1 (Windows 2000) 

 
 
 

3. Check the "Specify a location" check box only, then click Next>. 
 

Figure 10: Driver File Location 1 (Windows 2000) 

 

 
 

Click. 

Check that "Search for a 
suitable driver ..." is 
selected. 

Click. 

Check that "Specify a 
location" only is checked. 
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4. Enter "C:\Program Files\NECTools32\PG-LPC\DRIVERS" in the address bar, then click 

OK. 
 

Figure 11: Address Specification 1 (Windows 2000) 

 
Remark If the installation destination folder is changed at the time of PG-LPC GUI software 

installation, enter "new-folder\PG-LPC\DRIVERS". 
 
 

5. Click Next>. 
 

Figure 12: Driver File Search 1 (Windows 2000) 

 

Enter "C:\Program Files\NECTools32\PG-LPC\DRIVERS". 

Click. 

Click. 
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6. Click Finish to complete the installation of the USB driver. 

 

Figure 13: USB Driver Installation Completion 1 (Windows 2000) 

 
 
 

7. Proceed to the installation of the USB Serial Port driver.  Click Next>. 
 

Figure 14: Found New Hardware Wizard 2 (Windows 2000) 

 
 
 

 
8. The window below is displayed.  So, check that "Search for a suitable driver ..." is selected, 

then click Next>. 

Click. 

Click. 
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Figure 15: Search Method 2 (Windows 2000) 

 
 
 

9. Check the "Specify a location" check box only, then click Next>. 
 

Figure 16: Driver File Location 2 (Windows 2000) 

 
 

Click. 

Check that "Search for a 
suitable driver ..." is 
selected. 

Click. 

Check that "Specify a 
location" only is checked. 
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10. Enter "C:\Program Files\NECTools32\PG-LPC\DRIVERS" in the address bar, then click 

OK. 
  

    Figure 17: Address Specification 2 (Windows 2000) 

                   
Remark  If the installation destination folder is changed at the time of PG-LPC GUI software 
installation, enter "new-folder\PG-LPC\DRIVERS". 

 
 

11. Click Next>. 
  

Figure 18: Driver File Search 2 (Windows 2000) 

 

Enter "C:\Program Files\NECTools32\PG-LPC\DRIVERS". 

Click. 

Click. 
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12. Click Finish to complete the installation of the USB driver. 

  

   Figure 19: USB Driver Installation Completion 2 (Windows 2000) 

    
  
 

7.4.3 Installation on Windows XP 
 

1. When the Low Pin Count - Do it! board is connected with the host machine, the board 
recognized by Plug and Play, and the wizard for finding new hardware is started.  Check 
that "Install from a list or specific ..." is selected, then click Next>. 

 

Figure 20: Found New Hardware Wizard 1 (Windows XP) 

 
 

 

Check that "Install from a list 
or specific ..." is selected. Click. 

Click. 
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2. Check that "Search for the best driver in these locations." is selected.  Check the "Include 

this location in the search:" check box and enter "C:\Program Files\NECTools32\PG-
LPC\DRIVERS" in the address bar, then click Next>. 

 

Figure 21: Search Location Specification 3 (Windows XP) 

 
 

 
 
 
 

 
 
 

3. As shown below, "has not passed Windows Logo testing to verify its compatibility with 
Windows XP." is displayed.  Click Continue Anyway. 

 

Figure 22: Windows XP Logo Testing 3 (Windows XP) 

 

<1> Check that "Search for the 
best driver in these locations." 
is selected. 

<2> Check "Include this 
location in the search:" 
only. 

Click. 

<4>  Click. <3>  Enter "C:\Program Files\NECTools32\PG-LPC\DRIVERS". 
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4. When the window below is displayed, the installation of the USB driver is completed.  Click 

Finish. 
 

Figure 23: USB Driver Installation Completion 1 (Windows XP) 

 

 
 

5. Proceed to the installation of the USB Serial Port driver.  Click Next>. 
 

Figure 24: Found New Hardware Wizard 2 (Windows XP) 

 
 
 
 

Click. 

Check that "Install from a list 
or specific ..." is selected. Click. 
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6. Check that "Search for the best driver in these locations." is selected.  Check the "Include 

this location in the search:" check box and enter "C:\Program Files\NECTools32\PG-
LPC\DRIVERS", then click Next>. 

 

Figure 25: Search Location Specification 2 (Windows XP) 

 
 
 
 
 
 
 
 
 

7. As shown below, "has not passed Windows Logo testing to verify its compatibility with 
Windows XP." is displayed.  Click Continue Anyway. 

 

Figure 26: Windows XP Logo Testing 2 (Windows XP) 

 
 

<1> Check that "Search for the best 
driver in these locations." is 
selected. 

<2> Check "Include this location 
in the search:" only. 

<4>  Click. <3>  Enter "C:\Program Files\NECTools32\PG-LPC\DRIVERS". 

Click. 
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8. When the window below is displayed, the installation of the USB driver is completed.  Click 

Finish. 
 

Figure 27: USB Serial Port2 Driver Installation Completion (Windows XP) 

 
 
 
 

 

Click. 
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7.5 Confirmation of USB Driver Installation 

 
After installing the two types of USB drivers, check that the drivers have been installed 
correctly, according to the procedure below. When using the Low Pin Count - Do it! board, the 
information to be checked here is needed. 

 
 

By clicking the "Device Manager" tab, check that the drivers are installed correctly. 
 

Figure 28: Device Manager 

 
 

For Windows 98SE/Me 
Caution  Do not select Update and Erase when communicating with the 

Low Pin Count - Do it! board. 
 

For Windows 2000/XP 
Caution  Do not perform "Hardware Modification Scan" when communicating with the 

     Low Pin Count - Do it! board. 
 
 

Remark In the GUI port list box, the same communication port as COM? of USB Serial Port 
(COM?) needs to be selected. 

 
 If the drivers above are not displayed, or the mark "×" or "!" is prefixed, refer to 

CHAPTER 10 TROUBLESHOOTING. 
 

 

Check that "USB Serial Port 
(COM?)" is present. 

Check that "USB High Speed 
Serial Converter" is present. 
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7.6 Driver Uninstallation 

 
The driver uninstallation program is installed on the host machine when the PG-LPC software is 
installed.  
 
Use the procedure below for driver uninstallation. 

 
 

1. When using Windows 2000 or Windows XP, log on as computer administrator. 
 

2. Double-click in the order from "My Computer" to "(C:)" to "Program Files" to "NECTools32" 
to "PG-LPC" to "DRIVERS".  "Ftdiunin.exe" is displayed.  Double-click "Ftdiunin.exe". 

 
  

     Figure 29: Driver Uninstallation 

 

 
 
 

3. Click Continue. 
 

Figure 30: Driver Uninstaller 

 

Double-click. 

Click. 
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4. Click Finish to complete driver uninstallation. 

 

    Figure 31: Completion of Driver Uninstallation 

 
 

 
Caution If the PG-LPC software is uninstalled earlier, "Ftdiunin.exe" is also deleted. In 

such a case, delete "USB Serial Port (COM?)" and "USB High Speed Serial 
Converter" from Device Manager manually. 

 
 

Click. 
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8. PG-LPC FLASH programming software 

 

8.1 Starting up the GUI Software 
 

• GUI software startup 
 Select PG-LPC.EXE from the start menu to start the PG-LPC GUI software. 

 
 When the GUI software is started normally, the following screen appears. 

 
 

Figure 32: PG-LCP GUI Software Main Window 

 

 
 

Menu bar 

Toolbar 

Action log window 

Status bar 

Programmer 
parameter 
window 
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This window consists of the following items: 

   
Name Display Information 
Menu bar 
(displayed at the top) 

Displays menu items executable by the 
PG-LPC. 

Toolbar 
(displayed under the menu bar) 

Displays frequently used commands as 
icons. 

Action log window 
(displayed under the toolbar) 

Displays an PG-LPC action log. 
 

Programmer parameter window 
(displayed to the right of the action log 
window) 

Displays programming parameter 
settings. 
 

Status bar Displays status. 
 
 

8.2 Toolbar 
 

The toolbar contains buttons for starting the important procedures of the PG-LPC. 
 

Table 13: Toolbar Buttons 

 
[Device] → [Setup] button 

 
[File] → [Load] button 

 
[Device] → [Blank Check] button 

 
[Device] → [Erase] button 

 
[Device] → [Program] button 

 
[Device] → [Autoprocedure(EPV)] button 
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8.3 Menu Bar 

 
Depending on the actual device status and device type, some menu items may be enabled or 
disabled. 

 

8.3.1 [File] menu 
Clicking the [File] menu displays the pull-down menu as shown below. 
This menu mainly contains commands related to file operation. 

 

Figure 33:  [File] Menu 

 

 
 

(1) [Load] command 
The [Load] command allows you to select a program file. 
The selected program file is programmed into the flash memory of the device by 
executing the [Program] command or [Autoprocedure(EPV)] command. 

 

Figure 34: HEX File Selection Window 

 

 
 

 The file selection window for program loading displays the most recently used directory to 
which a user program has been loaded.  After a user program is loaded, a checksum 
calculation is made and the result is displayed in the programmer parameter window. 

 [  Open  button] 
 Selects a user program as a program to be written to the target device. 

 
 [  Cancel  button] 
 Closes the window without selecting a program. 
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(2) [Quit] command 
 The [Quit] menu is the command for terminating the PG-LPC GUI software. Clicking  ×  on 

the right side of the task bar also terminates the PG-LPC GUI software. 
 User settings are saved in the PG-LPC.ININote file, so that the GUI software starts up next 

time with the same settings. 
 

Note PG-LPC.INI is created in the Windows folder when Windows 98SE, Windows Me, or 
Windows XP is used. 

 When Windows 2000 is used, PG-LPC.INI is created in the WinNT folder. 
 

8.3.2 [Device] menu 
Clicking the [Device] menu displays the pull-down menu as shown below. 
This menu mainly contains commands for programming operations such as blank check, 
deletion and programming of the target device. 

 

Figure 35: [Device] Menu 

 
 

(1) [Blank Check] command 
The [Blank Check] command allows you to make a blank check on the 78K0S/KA1+ 
target device connected to the PG-LPC. If the flash memory of the device is erased, 
a blank check is terminated normally. If the flash memory is not completely erased, 
the indication "not blank" is provided. Before starting programming, erase the flash 
memory of the target device. 

 
(2) [Erase] command 

The [Erase] command erases the flash memory of the 78K0S/KA1+ device 
connected to the PG-LPC. While the flash memory is being erased, the progress 
status is displayed in the action log window to indicate programmer operation. 
The execution on the [Blank Check] command before the [Erase] command is 
executed follows the setting of 'Command options' of the Advance tab displayed by 
selecting [Device] → [Setup]. 
Upon completion of [Erase] command execution, the GUI software displays the result 
of executing the command on the target device. 
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(3) [Program] command 

The [Program] command sends a specified user program to the target device and 
writes the program to the flash memory. 
The execution of Verify operation for detecting an error in user program 
communication from the PG-LPC to the target device after the execution of the 
[Program] command follows the setting of the 'Command options' on the Advance tab 
displayed by selecting [Device] → [Setup]. 
During programming, the progress status is displayed in the action log window to 
indicate programmer operation. This progress status display window displays the 
progress status on target device programming by percentage. 
Upon completion of [Program] command execution, the GUI software displays the 
result of executing the command on the target device. 

 
(4) [Verify] command 

This command is not supported. 
 
(5) [Security] command 
 This command is not supported. 

 
(6) [Checksum] command 
 The [Checksum] command reads the checksum value of the 78K0S/KA1+ device 

connected with the PG-LPC. This value differs from the value displayed in the parameter 
window of the main window. 

 
(7) [Autoprocedure(EPV)] command 

The [Autoprocedure(EPV)] command executes the [Erase] command and [Program] 
command in succession. Upon completion of [Autoprocedure(EPV)] command 
execution, the GUI software displays the result of executing the command on the 
target device. 

 
(8) [Signature read] command 
 This command is not supported. 
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(9) [Setup] command 
The [Setup] menu allows you to make settings related to flash memory rewriting 
according to the user environment and to set command options.  Each time the GUI 
software is started, the most recently used parameter file (.PRM) is read and the 
settings are displayed.  The [Setup] menu allows you to modify the settings of items 
other than those items consisting of shadowed characters according to the user 
environment. 

 
(a) Standard setup 

This menu is used to set the environment for rewriting the flash memory of the target 
device. 
The mode of communication with the target, the operating clock, and so forth differ 
depending on the device used. The window shown below is opened. 

 

Figure 36: Device Setup Window - Standard 

 
 

This window shows all basic options that can be set in accordance with the user 
environment and target device. 

 
[  OK  button] 
Clicking the  OK  button saves the settings on the Standard and Advance menus and 
closes the window. 

 
[  Cancel  button] 
Clicking the  Cancel  button closes the window without saving the settings on the 
Standard and Advance menus. 
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<1> Parameter file 

This file holds parameters and timing data required to rewrite the flash memory of 
the target device.  Do not modify the data in the parameter file because the data is 
related to the guarantee of rewrite data. 
The parameter file is protected by the checksum function.  If the checksum result 
indicates an error, PG-LPC does not accept the parameter file. 

 
 

Figure 37: Setup Window - Parameter File Selection 

 
 

 

Figure 38: Parameter File Selection Window 

 
 

[  PRM File Read  button] 
A window for specifying a parameter file is displayed.  Specify a desired file then 
click Open. 
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<2> Communication interface to device 

"Communication interface to device" is used to select a channel for communication 
between the Low Pin Count- Do it! board and host machine. 

 

Figure 39: Setup Window - Communication interface to device 

 
 

[Port list box] 
Select a channel for communication between the Low Pin Count- Do it! board and 
host machine. 

 
Remark Selectable ports can be checked using Device Manager. For details, refer 

to 7.5 Confirmation of USB Driver Installation. 
 

[Speed list box] 
Select a communication rate for the selected communication channel. 
 

 
<3> Supply oscillator 

"Supply oscillator" is used to select a clock that determines programming, data 
transfer, and a transfer rate. 

 

Figure 40: Setup Window - Supply Oscillator Selection 

 
 

[Frequency box] 
Sets the clock frequency of the target system. 
The range of operating frequency varies from one device to another. So, check the 
specifications of the device used before making a setting. 
 
[Multiply rate] 
Specifies the division rate or multiplication rate of the target device. 
If the target device has an on-chip PLL circuit, enter a division rate or multiplication 
rate according to the use environment. 
The selectable division rate or multiplication rate differs depending on the device.  
Check the specifications of the device used before making a setting. 
If the target device does not have an on-chip PLL circuit, select "1.0". 
On the initial screen, the default setting is displayed according to the parameter file. 
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<4> Operation Mode 

The setting of "Operation Mode" may divide the flash memory of some target 
devices into blocks or areas. 
This menu is used to select an operation mode of the flash memory.  Some devices 
do not have the block and area division modes, and some devices have only one of 
the modes. In these cases, a nonexisting mode is unchoosable. 

 

Figure 41: Setup Window - Operation Mode 

 
 

[When Chip is selected] 
The entire flash memory area of the target device is subject to rewrite processing. 
 
[When Block is selected] 
Specify the Block number range subject to rewrite processing by using Start/End. 
The Start/End list boxes display the Block numbers where the flash memory of the 
target device is configured. 

 
[When Area is selected] 
Specify the Area number range subject to rewrite processing by using Start/End. 
The Start/End list boxes display the Area numbers where the flash memory of the 
target device is configured. 
 
[Show Address check box] 
Specify whether numbers or addresses are displayed in the Start/End list boxes. 
If this check box is checked, addresses are displayed. 
If this check box is not checked, numbers are displayed. 
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(b) Advance setup 

The Advance setup menu is used to specify the command options and security flag 
settings. 
When "Advance" is clicked, the following window is displayed: 

 

Figure 42:  Device Setup Window - Advance 

 
 

<1> Command options 
This dialog box is used to specify the PG-LPC flash processing command options. 

 

Figure 43: Setup Window - Command options 

 
 

[Blank check before Erase check box] 
If this check box is checked, blank check is made before the Erase command or 
EPV command is executed. 
If the result of a blank check indicates OK, erase processing is not executed. 
 
[Security flag after Program check box]  Not usable 

 
[Checksum after Program check box] 
If this check box is checked, the flash memory checksum value of the target device 
is read from the target device after execution of the Program command and EPV 
command. 
 
 
This value differs from the value displayed in the parameter window of the main 
window. 
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8.3.3 [View] menu 

 
Clicking the [View] menu displays the pull-down menu shown below. 
This menu contains commands for setting whether to display the toolbar and status bar. 

 

Figure 44: [View] Menu 

 
 
 

(1) [Toolbar] command 
 Checking the [Toolbar] command displays the toolbar. Unchecking the command hides the 

toolbar. 
 

 
(2) [Status Bar] command 
 Checking the [Status Bar] command displays the status bar. Unchecking the command 

hides the status bar. 
 

 
 
 
 
 
 
 
 



Low Pin Count – Do it!  

47 

8.3.4 [Help] menu 

 
Clicking the [Help] menu displays the following pull-down menu: 

 

Figure 45: [Help] Menu 

 
 
 
 

(1) [About PG-LPC] command 
 The [About PG-LPC] command opens the program entry window as shown below and 

indicates the version. 
 Clicking  OK  terminates the display. 
 

 

Figure 46: About PG-LPC Window 
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8.4 Programmer Parameter Window 
 

This window displays the settings of the programming parameters. 
 

Figure 47: Programmer Parameter Window 

 
 

[Device] 
Updated after communication with the target device to display information about the target 
device. 

 
[Parameter file] 
Updated after [Setup] command execution to display information about a read parameter file. 

 
[Load file] 
Updated after [Load] command execution to select information about a selected program file. 
 
[Connection to device] 
Updated after [Setup] command execution to display information about the connection with the 
target device. 
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9. How to use PG-LPC FLASH programming software 

 
This chapter explains the basic operations of the PG-LPC GUI for programming the  
Low Pin Count - Do it! board. This chapter covers how to start the system, execute the EPV command, 
and program the target device µPD78F9222 mounted on the Low Pin Count - Do it! board. 
 
The conditions of the series of operations described in this chapter are as follows: 
 
Target board Low Pin Count - Do it! 
Target device :  µPD78F9222 
Clock :  8 MHz 
Voltage level :  5 V 
 
PG-LPC 
Parameter file :  78F9222.PRM 
Clock setting :  8 MHz  Multiplied by 1 
Port :  COM4  (115200 bps) 
Operation mode: Chip 
Write HEX :  Light_demo.hex  
Option setting :  Blank check before Erase 

 

(1) Installing the PG-LPC GUI software 
Install the PG-LPC GUI software on the host machine you are using, by referring to CHAPTER 7 
SOFTWARE INSTALLATION (if the software has not been installed yet). 

 

(2) Installing the driver 
Install the USB driver on the host machine you are using, by referring to CHAPTER 7 
SOFTWARE INSTALLATION (if the driver has not been installed yet). 

 

(3) Installing the parameter file 
The parameter file for the µPD78F9222 device is installed automatically during installation of PG-
LPC GUI, folder <PG-LPC install-path>\PRM. Nevertheless, newest version of parameter file for 
the µPD78F9222 device can by download from the following URL: 
 
http://www.ee.nec.de/updates 
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(4) Connecting and starting 
 
<1> Set the Low Pin Count - Do it! board to the FLASH programming mode by switching SW3/S1 

to ON. The recommended configuration of connectors CN1, CN2 and CN12 is shown below: 
 
 

SW3 Setting  CN1 Jumper setting 
S1 ON  1-2 open 
S2 don’t care  3-5 closed 
S3 don’t care  4-6 closed 
S4 don’t care    

 

 
 
 

CN12 Jumper setting  CN2 Jumper setting 
1-2 closed  1-2 closed 
3-4 don’t care  3-4 don’t care 
5-6 don’t care  5-6 don’t care 
7-8 don’t care  7-8 don’t care 

9-10 don’t care  9-10 don’t care 
 
 
 
<2> <Plug and Play> Connect the Low Pin Count - Do it! board with the host machine via the 

USB cable. 
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<3> Start the PG-LPC GUI. 

 

Figure 48: GUI Software Startup Screen 

 
 

(5) Setting the programming environment 
<1> Select [Device] → [Setup] from the menu bar. 
<2> The Standard dialog box for device setup is activated. 
 

Figure 49: <Standard Device Setup> Dialog Box 
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<3> Click PRM File Read to open the parameter file selection window. 
 Select the parameter file “78F9222.prm” then click Open. 

 

Figure 50: Parameter File Selection 

 
 

 
<4> From the Port list box, select the communication port that matches the host machine being 

used. Select the communication speed of the Host connection. 
 

Figure 51: Port Selection 

 
 

 
Remark Selectable ports can be checked using Device Manager.  For details, refer to 7.5 

Confirmation of USB Driver Installation. 
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<5> Set "Supply oscillator" according to the specifications of the Low Pin Count - Do it! board,  

“Frequency = 8.00 MHz” and “Multiply rate = 1.00”. In "Operation Mode", please specify 
the “Chip” mode. The following figure shows the recommended settings: 

 

Figure 52: <Standard Device Setup> Dialog Box after Setting 

 

 
 
 

<6> Switch to the Advance dialog box. 
 

Figure 53: <Advance Device Setup> Dialog Box  

 
 

 
 <Command options>  

Blank check before Erase :  Checked 
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<7> Click the OK button.  The GUI software sets the parameters. 
 When the settings have been completed, the following screen is displayed: 

 

Figure 54: Completion of Parameter Setting 

 
 

(6) Selecting a user program 
<1> Select [File] → [Load]. 
<2> Select a program file to be written to the target device, then click Open. 
 

Figure 55: After Downloading 

 
 
 

The display is updated. 

"Success read HEX file." is 
displayed. 

"PRM File Read OK." is displayed. 

The display is updated. 
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(7) [Autoprocedure(EPV)] command execution 
Select [Device] → [Autoprocedure(EPV)] from the menu bar. 
When the [Autoprocedure(EPV)] command is executed, Blank Check → Erase → Program and 
FLASH Internal Verify are executed sequentially for the µPD78F9222 device. 

 

Figure 56: After EPV Execution 

 
 
  

(8) Terminating the GUI 
Select [File] → [Quit] to terminate the GUI software. All settings executed so far are saved in the 
PG-LPC.INI file, so that those settings can be reused when the GUI software is restarted. 

 

(9) Execute “LIGHT_DEMO” application 
Set the Low Pin Count - Do it! board to the normal operation mode by switching SW3/S1 to OFF. 
< Plug and Play> the Low Pin Count - Do it! board to start in normal operation mode. 

 

(10) Restarting the GUI 
When the system is restarted, the same screen as shown in Figure 54 appears. 

 
 

"...finish" is displayed. 
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10. TROUBLESHOOTING 
 

In driver installation, recognition based on Plug and Play is disabled. 
 

Cause: 
The USB connector may not be inserted normally into the USB port of the personal computer. 
Action: 
Check that the USB connector is inserted fully into the USB port of the personal computer. 
Alternatively, disconnect the USB connector, then insert the USB connector again after a while. 
 
 
The driver file cannot be found at a specified location. 

 
Cause: 
The PG-LPC software of the Low Pin Count - Do it! board may not be installed correctly. 
Action: 
Install the GUI software again by referring to CHAPTER 7 Software Installation. 

 
 

In checking by Device Manager, "USB Serial Port" or "USB High Speed Serial 
Converter" is not displayed.  Alternatively, the "!" or "×" is prefixed. 

 
Cause: 
The USB connector may not be inserted normally into the USB port of the personal computer. 
Action: 
Check that the USB connector is inserted fully into the USB port of the personal computer. 
Alternatively, disconnect the USB connector from the USB port, then insert the USB connector 
again after a while. 

 
Cause: 
The driver may not be installed correctly. 
Action: 
<1> When this product is connected to the personal computer, right-click the driver marked 

with "!" or "×". 
 Click Erase when displayed. 
<2> On Device Manager, execute [Hardware Modification Scan]. 
<3> Install the driver again with Plug and Play. 

 
Cause: 
The device may not be recognized (in the case of connection with the USB hub). 
Action: 
Try the following: 

•   Disconnect the USB connector, then insert the USB connector again. 
•   Connect the USB connector to another port of the USB hub. 

If the same symptom occurs, do not use the USB hub, but directly connect the connector to 
the USB port of the personal computer. 

 
 

When this product is connected with a personal computer, the "Add New Hardware 
Wizard" screen is displayed. 

 
Cause: 
If the USB connector of this product is inserted not into the USB port used at the installation 
time but into another USB port, this product may be recognized as a new hardware item. 
Action: 
Install the driver by referring to CHAPTER 7.4 Driver Installation. 
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Communication with the Low Pin Count - Do it! board is disabled. 

 
Cause: 
The driver may not be installed correctly. 
Action: 
Check if "USB Serial Port" and "USB High Speed Serial Converter" are installed correctly by 
referring to CHAPTER 7.4 Driver Installation. 

 
 

Cause: 
The Port list box may not be set correctly. 
Action: 
Set the port checked using Device Manager. 

 
Cause: 
The power, clock or reset signal may not be supplied to the 78K0S/KA1+ device correctly. 
Action: 
<1> Check that the clock is supplied to the 78K0S/KA1+ device, connector CN1. 
<2> Check that the power is supplied to the 78K0S/KA1+ device, connector CN12. 
<3> Check that the CPLD reset signal is supplied to the 78K0S/KA1+ device, connector 

CN2. 
 
 

Cause: 
The PRM file selected in [Device Setup] may be incorrect. 
Action: 
Use the 78F9222.prm that matches the Low Pin Count - Do it! target device. For information 
about the PRM file, refer to CHAPTER 8 PG-LPC FLASH programming software. 

 
Cause: 
The setting of "Supply oscillator" in [Device Setup] may be incorrect. 
Action: 
Make a correct setting according to the specifications of the target device. 
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11. Sample programs 

11.1 General Introduction 
Each of the sample programs is located in a single directory, which will be called main-directory of the 
sample. The five sample projects files are included in one IAR workspace file named 
“LPC_demo_projects.eww”. 
 

 
 
 
AD converter demonstration 
Light Show 
Reaction time measurement 
Timer demonstration 
UART demonstration 
workspace file, IAR Embedded Workbench 
 
 
 
 

 

 

Table 14: Example directory structure 

 
A main directory of each sample contains the project inclusive all output files of the development tools. All 
sample programs use the same directory structure: 
 

 
 
 
output files for IAR C-SPY simulator 
output files for Low Pin Count - Do it! board (i.e. Intel HEX file) 
linker command file 
dependency information file, IAR Embedded Workbench 
project setting file, IAR C-SPY debugger 
project file, IAR Embedded Workbench 
C source file 
 
 
 

 

 

Table 15: Example structure 

 
The main directory contains the project files for the IAR Systems Embedded Workbench, the corresponding 
C source file and the linker command file (xcl File).  
All output files of the development tools for each target are generated in the directories Debug and 
Release. One target is the IAR C-SPY simulator directory Debug and the other is the demonstration kit 
hardware directory Release. 
 
To open the IAR Systems Embedded Workbench for a sample program please double-click on the IAR 
workspace file “LPC_demo_projects.eww” in the directory SamplePrograms.  
 
For details of using IAR Embedded Workbench and IAR C-SPY Simulator please refer to the manuals. 
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Figure 57: IAR Systems Embedded Workbench 78K0/K0S 

 

 
Figure 58: IAR System 78K0/K0S C-SPY Simulator 
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11.2 ADC demo 

This sample program simulates a simple voltage meter. By using the integrated ADC, the voltage supplied 
to ADC on input channel 0, port P20/ANI0, is measured. The input voltage is adjusted by potentiometer 
R24. The board shows the measured voltage by flashing LED’s D1 to D4.  
 
 

Used Internal Peripherals Used External Parts 
Timer80 LED’s D1- D4 
A/D converter Potentiometer R24 
 Button SW2 

 
To run the ADC demo please set the configuration of switch SW3 and connectors CN1, CN2 and CN12 to 
the following: 
 

 
SW3 Setting  CN1 Jumper setting 
S1 OFF  1-2 open 
S2 OFF  3-5 closed 
S3 OFF  4-6 closed 
S4 OFF    

 

 
 
 

CN12 Jumper setting  CN2 Jumper setting 
1-2 closed  1-2 closed 
3-4 closed  3-4 closed 
5-6 closed  5-6 don’t care 
7-8 don’t care  7-8 don’t care 

9-10 don’t care  9-10 don’t care 
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11.3 Light demo 

This sample programs plays one of eight predefined lightshows. After the program-start-signal, the program 
plays the first lightshow. By pressing button SW1 the next show is selected. Pressing button SW2 restarts 
the application. 
 

Used Internal Peripherals Used External Parts 
Timer80 LED’s D1- D4 
 Button SW1 
 Button SW2 

 
To run the Light demo please set the configuration of switch SW3 and connectors CN1, CN2 and CN12 to 
the following: 
 

 
SW3 Setting  CN1 Jumper setting 
S1 OFF  1-2 open 
S2 OFF  3-5 closed 
S3 OFF  4-6 closed 
S4 OFF    

 

 
 
 

CN12 Jumper setting  CN2 Jumper setting 
1-2 closed  1-2 closed 
3-4 don’t care  3-4 closed 
5-6 don’t care  5-6 closed 
7-8 don’t care  7-8 don’t care 

9-10 don’t care  9-10 don’t care 
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11.4 ReacTime demo 

This sample program demonstrates a reaction time measurement. The application starts by flashing LED’s 
D1-D4 two times. After a press of button SW1 the application waits for a random time between 0.50 and 
3.45 seconds. Then LED D4 is switched on and measurement starts by incrementing a reaction counter 
every 50ms. The actual counter value is shown by LED’s D1-D4 (binary format) until the next keystroke of 
button SW1. After a press of button SW1 is detected, the measurement stops and the reaction time is 
shown by flashing LED’s D1-D4. Pressing button SW2 starts a new measuring cycle. 
 

Used Internal Peripherals Used External Parts 
Timer80 LED’s D1- D4 
TimerH1 Button SW1 
 Button SW2 

 
To run the ReacTime demo please set the configuration of switch SW3 and connectors CN1, CN2 and 
CN12 to the following: 
 

 
SW3 Setting  CN1 Jumper setting 
S1 OFF  1-2 open 
S2 OFF  3-5 closed 
S3 OFF  4-6 closed 
S4 OFF    

 

 
 
 

CN12 Jumper setting  CN2 Jumper setting 
1-2 closed  1-2 closed 
3-4 don’t care  3-4 closed 
5-6 don’t care  5-6 closed 
7-8 don’t care  7-8 don’t care 

9-10 don’t care  9-10 don’t care 
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11.5 Timer demo 

This sample program simulates a darkroom timer. The board starts after reset flashing all LED’s. 
After first key press of SW1, the board starts counting up expose times in unit of minutes (binary output 
format). By pressing SW1 a second time the shown elapse time is selected and counting is started. 
After the selected time is finished the elapse time is displayed by flashing the LED’s twenty times and the 
stop mode is entered. By pressing SW1 stop mode can be released. 
 

Used Internal Peripherals Used External Parts 
Timer80 LED’s D1- D4 
TimerH1 Button SW1 
 Button SW2 

 
To run the Timer demo please set the configuration of switch SW3 and connectors CN1, CN2 and CN12 to 
the following: 
 

 
SW3 Setting  CN1 Jumper setting 
S1 OFF  1-2 open 
S2 OFF  3-5 closed 
S3 OFF  4-6 closed 
S4 OFF    

 

 
 
 

CN12 Jumper setting  CN2 Jumper setting 
1-2 closed  1-2 closed 
3-4 don’t care  3-4 closed 
5-6 don’t care  5-6 closed 
7-8 don’t care  7-8 don’t care 

9-10 don’t care  9-10 don’t care 
 
 
 

 
 



Low Pin Count – Do it!  

64 

 

11.6 UART demo 

This sample program simulates a voltage meter with serial communication channel. The sample program 
does a cyclic measurement of the input voltage of AD converter channel 0, port P20/ANI0, and transfers the 
measured result via UART6 to a terminal program running on the host machine. The data transfer speed is 
set to 115200 bps per default. The input voltage can be changed by potentiometer R24. 
 

Used Internal Peripherals Used External Parts 
Timer80 LED’s D1-D4 
A/D converter Button SW2 
UART6  

 
To run the UART demo please set the configuration of switch SW3 and connectors CN1, CN2 and CN12 to 
the following: 
 

 
SW3 Setting  CN1 Jumper setting 
S1 OFF  1-2 open 
S2 ON  3-5 closed 
S3 OFF  4-6 closed 
S4 OFF    

 

 
 
 

CN12 Jumper setting  CN2 Jumper setting 
1-2 closed  1-2 closed 
3-4 closed  3-4 closed 
5-6 closed  5-6 don’t care 
7-8 closed  7-8 don’t care 

9-10 closed  9-10 don’t care 
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12. Connectors and Cables 

 

12.1 USB host connector CN7 
 

Figure 59: Connector CN7, USB Mini-B Type Host Connector Pin Configuration 

1 5

 
 
 

Table 16: Pin Configuration of USB Connector CN7 

USB Connector 
CN7 

Signal Name 

1 VBUS 
2 DM 
3 DP 
4 N.C. 
5 GNDBUS 

 
 

For connection with the host machine, use a USB cable (Mini-B type). For confirmation, 
NEC Electronics used only the USB cable delivered with the Low Pin Count - Do it! board. 
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12.2 USB interface cable (Mini-B type) 

 

 
Figure 60: USB interface cable (Mini-B type) 
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13. Schematics 

 
Figure 61: Low Pin Count - Do it! board schematics 

Remark: Schematics also available on CDROM directory \Doc\
                  file “LPCDOIT_BOARD_SCHEMATICS.pdf” 


